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Apple Push Notification Service
(APNS)

What Is APNs

Apple Push Natification service (APNSs) is a highly secure and efficient system for communicating with iOS
devices over-the-air (OTA). Each device establishes an accredited and encrypted IP connection with the
service. The provider, in this case your ZENworks Mobile Management server, connects with and sends its
notification to the APNs, which pushes the notification to the target device.

An APNSs certificate is required for Apple Push Notification service. The certificate must be renewed annually.
This guide explains the process of obtaining the APNs certificate from Apple and provides instructions on how
to upload the certificate to the ZENworks Mobile Management server via its dashboard.

There are various methods of generating the APNSs certificate, any of which you may use. This document
guides you through generating the certificate by using Microsoft Windows Internet Information Services (IIS)
Manager, version 6, 7, or 8.

How APNs Works

Apple Push Notification service works in conjunction with the built-in MDM protocol of Apple iOS devices.
ZENworks Mobile Management uses the Apple Push Notification service to send notifications to the iOS
device requesting information. Only notifications, not data, are sent through the APNs server. The device
responds directly to the ZENworks Mobile Management server.

The Apple MDM protocol provides the following functionality:
o Devices support Selective Wipe, Lock Device, and Clear Passcode
e Full Wipe and Lock Device commands are applied immediately
e You can record and access installed applications on devices
e You can record and access installed configuration profiles on devices
e You have access to additional device statistics
e Configuration profile updates require no user interaction
e Enterprise (in-house) apps
e Mobile App Management
¢ Manage VPP (Redemption) Codes
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Requirements

e ZENworks Mobile Management version 2.5.2 or later

e An Apple ID. We recommend that you do not use a personal Apple ID, but create a separate
corporate Apple ID for MDM. Associate the Apple ID with an email account that will remain with your
company — not an email account that belongs to an individual in the company. This facilitates a
smooth certificate renewal process each year.

e Windows Server 2003, 2008, or 2012 (you need administrator permissions)

e Firefox or Safari Web browser

An Overview of the Steps to Obtain the Apple Push Notification Service Certificate

1. Create a Certificate Signing Request (CSR). (This guide provides instructions for creating the
certificate from Microsoft Windows Internet Information Services (IIS) Manager, version 6, 7, or 8. An
alternate method, using OpenSSL, is documented in Appendix A.)

2. Upload the CSR to the ZENworks Mobile Management Certificate Portal. Novell, Inc. signs the CSR.

Upload the intermediate certificate (the CSR signed by Novell, Inc.) to the Apple Push Certificates
Portal. Apple issues the certificate.

4. Download the signed certificate from the Apple Push Certificates Portal and complete the certificate
request in IIS.

5. Export the certificate to a file.

Upload the certificate to the ZENworks Mobile Management server.

Generating an Apple Push Notification Service Certificate for use with
ZENworks Mobile Management for iOS

1.

Create a Certificate Signing
Request (CSR) in IIS.

The IS server and the
ZENworks server can be the
same server, but this is not
required.

5.

Export the certificate you just
created as a .pfx file.

(Create a password while
exporting.)

Use IIS to complete the
certificate request
process by using the
certificate issued by
Apple.

Use the ZENworks Mobile
Management dashboard to upload
the APNs certificate to the ZENworks
server.

Log in to the dashboard with the
external server address so that the
Use Default URLs option can be
utilized.

Novell,

2.

Upload the signed Intermediate Certificate to

Upload the CSR to the ZENworks Certificate
portal to get it signed by Novell. A .request
file is generated.
https://zmmupdate.novell.com/apn/

the Apple Push Certificates portal. Apple
issues the certificate in a .pem file
format. Download this file.
https:/fidentity.apple.com/pushcert/
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Generating an APNs Certificate

Generating an APNs Certificate from Windows Server 2003

The following instructions are for generating an APNSs certificate from a Windows Server 2003 by using
Internet Information Services (1IS) Manager version 6. You can skip this section if you use Windows Server
2008 or 2012. For Windows Server 2008 or 2012, see Generating an APNs Certificate from Windows Server
2008 or 2012.

Note: Appendix A provides instructions for an alternate method of generating the APNs certificate using
OpenSSL.

Creating the Certificate Signing Request (CSR) from IIS Manager 6

1.

Select Start > Control Panel > Administrative Tools > Internet Information Services (IIS)

Manager.

Right-click any Web site in the left panel. Select Properties.

Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

Default Web Site Properties

WebSte |  ISAPIFiters |
Directory Security HTTP Headers |

Home Directary I
Custom Emors I

21 x|

Documents

ASP.NET

r Anonymous access and authertication cantrol

=

[t

Enable anomymous access and edit the

authentication methods for this resource. Edit... |

[P address and dormait name restictions

e

[arant or deny acsess bojthis resaurce using
|IF addresses or intemet domain names.

Edit... |

rF

r Secure communications

Require secure communications and
enable client certificates when this
resounce is accessed.

Wiew Certificate... |
Edit... |

x

oK Cancel |

Apply

Help
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4. Select the Create a new certificate option and click Next.

5. Select Prepare the request now, but send it later option and click Next.

IS Certificate Wizard
Server Certificate
There are five methods for assigning a certfficate to a Web site.

Select the method you want to use for this web site:
(¢ Create a new certfficate.

(" Assign an existing certificate

(" Import a cerificate from a Key Manager backup file.

IS Certificate Wizard
Delayed or Immediate Request

You can prepare a request to be sent later, or you can send one
immediately.

Do you want to prepare a certificate request to be sent later, or do yo
immediately to an online certification authority?

¥ Prepare the request now, but send it later

' & Send the reque

timmediately to an orline certification authority

6. Enter a certificate name that is easily remembered. In the Bit length field, select 2048 for the
encryption level, then select Select cryptographic service provider (CSP) for this certificate. Click

Next.

7. From the Available Providers window, select Microsoft RSA SChannel Cryptographic Provider.

Click Next.

IIS Certificate Wizard
Mame and Security Settings
Your new certificate must have a name and a specific bit length.

Type a name for the new certificate. The name should be easy for you ko refer to and
remernber.

Marne:

The bit length of the encryption key determines the certificate’s encryption strength.
The greater the bit length, the stronger the security. However, a greater bit length may
decreasze performance.

Bit length: |2u43 vI

[T Select cryptographic zervice provider [CSF) far this certificate

IS Certificate Wizard
Available Providers

The cryptographic providers you can use for your certfficate are listed
below.

Select a provider

Microsoft DH SChannel
Microsoft RSA SChannel

ptographic Provider

yptographic Provider

Cancel

< Back I Mest » I
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8. Enter the legal name of your Organization and the Organization unit, which is the department

within your organization. Click Next.

9. Inthe Common name field, enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the corporate
APNSs certificate. The Apple ID might be in the form of an email address, or possibly a display name.

Click Next.

115 Certificate Wizard

Organization Information
'our certificate must include infarmation about your organization that
digtinguishes it from other organizations.

Select or type your organization's name and your organizational unit. Thiz iz tepically the
legal name of your organization and the name of pour divigion or department.

Far further infarmation, consult certification autharity's Web site.

Organization:

INoveII, Inc. j
Organizational unit:

Tl =l

Cancel

< Back I Mest » I

IIS Certificate Wizard

Your Web site's common name is its fully qualified domain name.

Your Site's Common Name
\?’

Type the common name for your site. |f the server is on the Intemet, use a valid DNS
name. |f the server is on the intranet, you may prefer to use the computer's NetBIOS
name.

If the common name changes, you will need to obtain a new certificate.

LCommon name:
My SpplelD|

< Back l NMext > I

Cancel

10. Enter the Country/Region, State/Province, and City/locality of your organization. Click Next.

In the Certificate Request File Name window, save the CSR to your computer. Record the location
and filename. This is the file you will upload to the ZENworks Mobile Management Certificate

Request Portal. Click Next.

115 Certificate Wizard
Geographical Information
The certification autharity requires the following geographical information.

LCountrp/Region:
IUS [United States) VI

State/province:

fUtsh I
City/locality:
IProvd j

State/province and City/lacality must be complete, official names and may not contain
abbreviations.

Cancel

< Back I Mest » I

TIS Certificate Wizard
Certificate Request File Name
Your certificate request is saved as a text file with the file name you
specify

Enter a file name for the certfficate request.

File name:
c:\AppleMDM_CSR td|

@

11. Review the information for the certificate request in the Request File Summary window. To make
revisions, click the Back button. Click Next to accept, then click Finish.
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated through [IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You will need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at
https://zmmupdate.novell.com/apn

€3 Novell.

&

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

Browse... |

GetSigned Request |

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/

2. Log in by using your Apple ID and password. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNSs certificate.
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-

Store

iPod

iPhone

Apple Push Certificates Portal

iPad

iTunes
Forgot your password?

Support

Q

Sign in
Copyright ® 2011

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller.

Apple Inc. All rights reserved

>

Terms of Use Privacy Policy

Mac

3. Select Create a Certificate.
Store

Apple Info

Site Map

iPod
Get Started

Hot News
iPhone

Apple Push Certificates Portal

FAQ

iTunes

RSS Feeds Contact Us
iPad
Notification Service and your Apple devices.
Create a Certificate

Support

Q

What about OS X Server?

Create a push certificate that enables your third-party server to work with the Apple Push
Learn more about Mobile Device Management

devteam@notifycorp.com

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info Site Map Hot News. RSS Feeds Contact Us %
Copyright © 2011 Apple Inc. All rights reserved. Terms of Use Privacy Policy
4. Read the Terms of Use and accept the End User License Agreement.
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Store Mac iPod iPhone iPad

Apple Push Certificates Portal

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONDITIONS CAREFULLY BEFORE
DOWNLOADING OR USING THE APPLE CERTIFICATES. THESE TERMS AND CONDITIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANY/ORGANIZATION AND APPLE.

MDM Certificate Agreement
(for companies deploying mobile device management for iOS products)

Purpose

Your company, organization or educational institution would like to use the MDM Certificates (as defined
below) to enable You to either deploy a third-party commercial, enterprise server software product for mobile
device management of iOS products, or deploy Your own internal mobile device management for iOS
products within Your company, organization or educational institution. Apple is willing to grant You a limited
license to use the MDM Certificates as permitted herein on the terms and conditions set forth in this
Agreement.

1. Accepting this Agreement; Definitions

1.1 Acceptance

In order to use the MDM Certificates and related services, You must first agree to this License Agreement. If
You do not or cannot agree to this License Agreement, You are not permitted to use the MDM Certificates or
related semvices. Do not download or use the MDM Certificates or any related semvices in that case.

¥ | have read and agree to these terms and conditions.

Printable Version >

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info

Copyright ® 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

iTunes

-

=

Site Map

Support Q

devteam@notifycorp.com Sign out

Hot News

RSS Feeds Contact Us

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile

Management Certificate Portal.

Store Mac iPod

Apple Push Certificates Portal

Create a New Push Certificate

Upload your Certificate Signing Request signed by your third-party server
vendor to create a new push certificate.

Browse_

Sl -

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Site Map

upport

devteam@notifycorp.com

Hot News

RSS Feeds Contact Us
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6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.

Select Download to download the Apple signed certificate.

Service Vendor Expiration Date™ Status Actions

“Revoking or allowing this centificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.

Learn more about MDM push certificate migration

Shop tha Appla Onlina Stora (1-800-MY-APPLE), visit an Apple Ratail Stors, or find a rezalier. Appis info Sita Map Hot Naws

Copyright © 2012 Appls knc All rights retarved. Tarms of Use Privacy Policy

4 Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Certificates for Third-Party Servers

Mobile Device Management  Novell Inc Jun 15, 2013 Active m

RSS Faads Contact Uz é

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile

Management server.
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Completing the Certificate Request from IIS Manager 6

1. Return to the IIS Manager. Select Start > Control Panel > Administrative Tools > Internet
Information Services (lIS) Manager.

Right-click any Web site in the left panel. Select Properties.

3. Select the Directory Security tab and then click the Server Certificates button in the Security
section of the menu. This starts the Web Server Certificate Wizard. Click Next to continue.

Select the Process the pending request and install the certificate option and click Next.

Browse to the aps_production_identity.pem file that was provided by Apple. Click Next.

IIS Certificate Wizard 1IS Certificate Wizard [X]

=y Process a Pending Request
Pending Certificate Request Process a pending certificate request by retrieving the file that contains ®
A pending certificate request is a request to which the certification the certification authority's response. \

authority has not yet responded

Enter the path and file hame of the file containing the certification authority's response.

A certificate request is pending. What would you like to do? Eath and fils name:

c:\aps_production_identity. pem| Browse... I

(% Process the pending request and install the certfficate

(" Delete the pending request

< Back I Next > I Cancel l

6. On the Certificate Summary screen, verify that the certificate information is correct and click Next,
then click Finish.

7. Open the Microsoft Management Console (MMC). Click Start > Run and enter MMC.
8. From the File menu, select Add/Remove Snap-in.
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9. From the drop-down list at Snap-ins added to, select Console Root and click Add. On the Add
Standalone Snap-in screen, select Certificates, then click Add.

Standalone I Extensions | Available standalone snap-ins:

Snap-in | Yendor | -
@ .MET Framework 1.1 Configuration  Microsoft Corporation
e'@.ﬂtctive Direckary Domains and Trusts  Micrasoft Corporation

Use this page to add or remowve a stand-alone snap-in from the console.

3nap-ins added to: |@ Console oot j Active Directory Sites and Services  Microsoft Corporation o
@Active Directory Users and Compu...  Microsoft Corporation
gfl Activey Conkrol Microsaft Corporation
Authorization Manager Iicrosoft Corporation
Certificate Templates Microsoft Corporation
Cerkif 5 icrosoft Corporation
@Certification Authority Iicrosoft Corporation
@ Cormponent Services Microsaft Corporation ;I
=4
— Description

The Certificates snap-in allows viou to browse the contents of the
certificate stores for wourself, a service, or a computer,

i~ Description

Add Close

Remayve About, . |

Ok | Cancel |

10. On the Certificates snap-in screen, select Computer account and click Next. Choose Local
computer and click Finish.

Certificates snap-in x|

Thiz gnhap-in will always manage certificates for:

by uzer account

r-
i Service account
o

Computer account

Select Computer x|

Select the computer you want thiz snap-in ko manage.

— Thiz shap-it will always manage:

i+ LLocal computer: [the computer this consale is running onk

i~ ancther computer; I Browse.. |

[ Allow the selected computer to be changed when launching from the command line. T his
only appliez if pou zave the conzole.

11. Click Close. Click OK on the Add/Remove Snap-in screen.
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12. At the Console Root, expand the directory. Select Certificates > Personal > Certificates. Right-click
on the certificate file and select All Tasks > Export. This opens the Export Wizard. Click Next to
continue.

'i'ﬁ. Console Root' Certificates (Local Computer)' Personal’,Certificates

[ Console Roat
E@ Certificates {Local Compr
ED Personal

L 5] Certificates
[-[Z] Trusted Root Certific

I:I Enterprise Trust Cut | Expart...
I:I Interrnediate Certific Copy
I:I Trusked Publishers Delete
-2 Unbrusted Certificate ]
|:| Third-Party Rook Cer Fliclsitelei
D Trusked People Help
[-[Z] Certificate Enrollmen
-3 sPC
< | i KN |

| d

|C0ntains actions that can be performed on the item. |

13. Select Yes to export the private key, then click Next.

Certificate Export Wizard |

Export Private Key
You can choose to export the private kew with the certificate.

Private keys are password protected. IF wou want to export the private kew with the
certificate, wou must type a password on a laker page,

Do you wank ko expark the private key with the certificate?

% ¥es, export the private keyi

™ Mo, do not expart the private key
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14. Select the Personal Information Exchange — PKCS #12 (.PFX) format and select the Enable
strong protection box. Click Next.

Certificate Export Wizard x|

Export File Format
Zertificates can be exported in a variety of file Formats,

Select the Format wou want o use:
€ DER encoded binary. #.509 (, CER)
" Base-64 encoded %509, CER)
) Cryptographic Message Synbax Standard - FRES #7. Certificates (,E7E]

I™ | Include all certificates in Ehe certification path if possible

[0 Personal Information Exchange - PKCS #12 (PR

[ Include all certificates in the certification path if possible
¥ Enable strong protection (requires IE 5.0, WT 4.0 5P4 or above)

[ Delete the private key if the export is successFul

< Back I Mexk = I Cancel

15. Enter and confirm a password. You will need this password when you upload the certificate to
ZENworks Mobile Management. Click Next.

Certificate Export Wizard E3

Password
To maintain security, you must protect the private key by using a password.

Type and confirm a password.

Password:

Confirm password:

< Back I Mext = I Cancel
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16. Click the Browse button and select the .pfx file that you want to export. Click Next.

Certificate Export Wizard [ X]

File to Export
Specify the name of the file you want to export

File name:

C:\com.yourcompany . mdm.pFx Browse... I

Cancel |

17. Click Finish to complete the certificate export. You see a message that says the export was
successful.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the
following:

o APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Generating an APNs Certificate from Windows Server 2008 or 2012

The following instructions are for generating an APNs certificate from Windows Server 2008 or 2012 by using
Internet Information Services (1IS) Manager version 7 or 8. You can skip this section if you use Windows
Server 2003. For Windows Server 2003, see Generating an APNs Certificate from Windows Server 2003.

Note: Appendix A provides instructions for an alternate method of generating the APNs certificate using

OpenSSL.

Creating the Certificate Signing Request (CSR) from IIS Manager 7 or 8

1. Navigate to Administrative Tools and select Internet Information Services (11S) Manager.

2. Select the server name in the left panel, then double-click the Server Certificates option in the
Security section of the menu.

"!Elnternet Information Services (IIS) Manager

GO (5

File  View Help

Comnections
€-i|7 |8
@ Start Page
B.ﬁi—i .
= Application Pools
[+ @] Sites

Authentication CaI

QJI Home
Group by:  Area x ?3‘ X
IIS

.‘31?_» cor |

Compression

B = 4

Logging MIME Types Modules

Management
=
h E
Feature Shared

Delegation  Configuration

o ' |!.-;§
E)J ‘ 404 <?_1
Directory Error Pages Handler
Browsing Mappings
o
Xy
Waorker
Processes

3. From the Actions menu in the right panel, select Create Certificate Request. This starts the Request

Certificate Wizard.

Import...

| Create Certificate Request...

Complete Certificate Request. ..

Create Domain Certificate. ..

Create Self-Signed Certificate. ..

'3@' Help

Online Help
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4. Enter the following in the Distinguished Name Properties window:

¢ Common name — Enter a valid Apple ID. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the
corporate APNs certificate. The Apple ID might be in the form of an email address, or
possibly a display name.
Organization — The legal name of your organization
Organization unit — The department within your organization
City/locality — City in which your organization is located
State/province — Abbreviation for the state or province in which your organization is located
Country/region — Abbreviation for the country or region in which your organization is located

Request Certificate 2 | x|

|| Distinguished Name Properties

gl

Specify the required information For the certificate, Statefprovince and Cityflocality must be specified
as official names and they cannot contain abbreviations,

COmman nare: IMy AppleID

Organization: INovell Inc

rganizational unit: IIT

Cibwlocality IPrnvD

Skate/province: Iutah|

Countryregion: |L|S j

Preyvious | Mexk I Fimish Cancel

5. Select Next.

6. Inthe Cryptographic Service Provider Properties window, accept the default setting, Microsoft RSA
SChannel Cryptographic Provider. In the Bit length field, select 2048 for the encryption level. Click
Next.

Request Certificate E3 I

Cryptographic Service Provider Properties
1

g;o

Select 3 cryptographic service provider and a bit length. The bt length of the encryption key
determines the certificate’s encryption strength. The greater the bit length, the stronger the security,
However, a greater bit length may decrease parformance.

Cryptographic sarvice provider:

e
Microsoft RSA SChannel Cryptographic Provider

{2048 . ~|

Previous “ Next I Fnils Cancel I
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7. Inthe File Name window, save the CSR to your computer. Record the location and filename. Click
Finish. This is the file you will upload to the ZENworks Mobile Management Certificate Request

Portal.

g

File Name

Specify the File name Far the certificate request, This information can be sent to a certification
autharity Far signing.

Specify a file name fFor the certificate request:

fc:iappleriDM_CsR.bx] . |

Prewious MExt | Finish I Zancel
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Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal

The CSR file you generated by using 1IS must be signed by Novell before you can upload it to the Apple Push
Certificates Portal. You need:

e Access to the CSR file

e Your Novell login credentials

1. Navigate to the ZENworks Mobile Management Certificate Portal at:
https://zmmupdate.novell.com/apn

€7 Novell.

&

Select a certificate signing request to upload.
(File size is required to be less than 10KB.)

Browse... |

Get Signed Request |

2. Browse to select the CSR file.
3. Click Get Signed Request.

4. Save the signed request.

You are now ready to upload the signed ZENworks.request file (the intermediate certificate) to the Apple
Push Certificates Portal.

Uploading the Intermediate Certificate to the Apple Push Certificates Portal

At the Apple Push Certificates Portal, you accept a license agreement and upload the intermediate certificate
that you downloaded from the ZENworks Mobile Management Certificate Portal. A new Apple signed push
certificate is created for you to download.

1. Browse to the Apple Push Certificates portal at: https://identity.apple.com/pushcert/ .
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2. Log in by using your Apple ID and password. This does not need to be an Apple Developer
account ID, but you should use an Apple ID that has been designated for managing the

corporate APNs certificate.

-

- Store Mac iPod iPhone iPad

Apple Push Certificates Portal

Forgot your password?

Sign in

iTunes

Support Q

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller. Apple Info Site Map Hot News RSS Feeds Contact Us %
Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy
3. Select Create a Certificate.
= e - - -
- Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Get Started

Create a push certificate that enables your third-party server to work with the Apple Push
Notification Service and your Apple devices.

FAQ

Learn more about Mobile Device Management
What about OS X Server?

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller Apple Info

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Site Map

devteam@notifycorp.com Sign out

()

Hot News

RSS Feeds

Contact Us
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4. Read the Terms of Use and accept the End User License Agreement.

iPhone iPad iTunes

Store Mac iPod Support

Apple Push Certificates Portal

Terms of Use

PLEASE READ THE FOLLOWING LICENSE AGREEMENT TERMS AND CONDITIONS CAREFULLY BEFORE ﬂ
DOWNLOADING OR USING THE APPLE CERTIFICATES. THESE TERMS AND CONDITIONS CONSTITUTE A
LEGAL AGREEMENT BETWEEN YOUR COMPANY/ORGANIZATION AND APPLE.

MDM Certificate Agreement
(for companies deploying mobile device management for iOS products)

Purpose

Your company, organization or educational institution would like to use the MDM Certificates (as defined
below) to enable You to either deploy a third-party commercial, enterprise server software product for mobile
device management of iOS products, or deploy Your own internal mobile device management for iOS
products within Your company, organization or educational institution. Apple is willing to grant You a limited
license to use the MDM Certificates as permitted herein on the terms and conditions set forth in this
Agreement.

1. Accepting this Agreement; Definitions

1.1 Acceptance

In order to use the MDM Certificates and related services, You must first agree to this License Agreement. If

You do not or cannot agree to this License Agreement, You are not permitted to use the MDM Certificates or
related services. Do not download or use the MDM Certificates or any related services in that case. ll

¥ | have read and agree to these terms and conditions.

Printable Version >

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store; or find a reseller. Apple Info Site Map Hot News

Terms of Use Privacy Policy

Copyright ® 2011 Apple Inc. All rights reserved

RSS Feeds

Q

Contact Us

4
e

devteam@notifycorp.com Sign out

5. Select and upload the intermediate certificate you downloaded from the ZENworks Mobile

Management Certificate Portal.

Store Mac iPod iPhone iPad iTunes

Support

Apple Push Certificates Portal

Create a New Push Certificate

Upload your Certificate Signing Request signed by your third-party server
vendor to create a new push certificate.

Browse_

Sl -

Q

Shop the Apple Online Store (1-800-MY-APPLE), visit an Apple Retail Store, or find a reseller.

Copyright © 2011 Apple Inc. All rights reserved.  Terms of Use Privacy Policy

Apple Info

Site Map

Hot News

RSS Feeds

Contact Us

devteam@notifycorp.com

L~
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6. When the upload has finished, a new certificate for ZENworks Mobile Management appears.

Select Download to download the Apple signed certificate.

Service Vendor Expiration Date™ Status Actions

“Revoking or allowing this centificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
Learn more about Mobile Device Management

MDM push certificates created in the iOS Developer Enterprise Program have been
migrated to the Apple Push Certificate Portal.

Learn more about MDM push certificate migration

Shop tha Appla Onlina Stora (1-800-MY-APFLE), visit an Apple Retail Stors, o find = rezaliar Appis info Sita Map Hot Naws

Copyright © 2012 Appls knc All rights retarved. Tarms of Use Privacy Policy

4 Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal

Certificates for Third-Party Servers

Mobile Device Management  Novell Inc Jun 15, 2013 Active m

P

RSS Faads Contact Us

You are now ready to complete the CSR and export the APNs certificate to the ZENworks Mobile

Management server.
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Completing the Certificate Request from IIS Manager 7 or 8

1. Return to Internet Information Services (IIS) Manager > Server Certificates and select Complete
Certificate Request from the Actions menu in the right panel. This starts the Complete Certificate

Request Wizard.

Import...

Create Certificate Request. ..

'—Complete Certificate Request...

Create Domain Certificate. ..

Create Self-Signed Certificate. ..

6 Help
Online Help

2. Browse to the aps_production_identity.pem file that was provided by Apple and enter a friendly name.
This is simply a label you give the certificate to easily distinguish it. You might want to give it a name
in which your company is identified.

Complete Certificate Request K E3

| 1 Specify Certificate Authority Response

g

Complete a previously created certificate request by retrieving the file that contains the certificate
authority's response.

File name containing the certification authority's response:
IC:\.aps _production_identity.pem I

Friendly name:

|com. yourcompany . mdm|

OK I Cancel |

3. Select OK to install the certificate to the server. You should see the certificate listed in the center
panel of Server Certificates.
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4. Export the certificate so that it can be uploaded to ZENworks Mobile Management. Right-click the

certificate you just installed and select Export.

'!Elnternet Information Services {I1IS) Manager

I[=] B3

@\—.4 lefi’ »

|& - @ -

File  View Help

rEETEITY le Server Certificates

©5 Start Page:

x — configured for SSL.
L=} Application Pools

(& Sites MName = | 1ssued To

- Use this feature ko request and manage certificates that khe Web server can use with Web sites

Imiport...

Create Cerkificate Request...

Complete Certificate Request..,

com. yourcompany, VDM Apple Produck

I Issued By

Create: Domain Certificate. ..

Create Self-Signed Certificate. ..

Create Certificate Request... View...
Cormnplete Certificate Request. .. Export...
Renew...
Create Domain Certificate:... 8¢ -Reinove
Create Self-Signed Certificate... @ Help
View. .. Online Help
| Export, .. |
Renew...
X Remove
f:)' Help
Online Help

5. Save the file to your Desktop in the .pfx format. You must set a password. You will need this
password when you upload the certificate to ZENworks Mobile Management.

Export bo:

IC:'I,l:l:um.';.ﬂ:uurcl:umpany.mdm.pr o

Passwiord:

Confirm password:

(04 I Zancel

You have successfully generated your APNs certificate.

Now you are ready to upload the certificate to ZENworks Mobile Management. You need the

following:

e APNs certificate file (.pfx format)

e The password you set when exporting the certificate

Continue with Upload the APNs Certificate to ZENworks Mobile Management.
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Uploading the APNs Certificate to
ZENworks Mobile Management

This section explains how to upload the APNs certificate to ZENworks Mobile Management by using the
ZENworks Mobile Management dashboard. You need:

e APNSs certificate file (the .pfx format)

e The password you set when exporting the certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.
3. Click the Upload button next to the APNs Certificate field.

Apple Push Notifications X

Choose an APNs Certificate File: Browse...

Certificate Password:

AppleiD: | |

Use Default URLs:

Server URL: 1 l

e.g., https: ServerAddress>/sync/iOSMDMSync.php

Check in URL: l

e.g., https ServerAddress>/sync/iOSMDMSync.php

Click the Browse button, then navigate to and select the APNs certificate file (.pfx format).
In the Certificate Password field, enter the password you set when exporting the certificate.

6. Enter the Apple ID used to generate the certificate, if you want to display it for reference on the
Organization Settings page. This information can be useful at renewal time.

7. Check the Use Default URLs box to populate the Server URL and Check in URL fields with
https://<ServerAddress>/sync/iOSMDMSync.php. This is the required format of the URLSs. Verify that
the <ServerAddress> is the external address of the ZENworks Mobile Management server.

Note: If you did not access the dashboard externally, do not use the default check box. Enter
the Server URL and Check in URLs manually, in the format noted above.
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8. Click the Submit button.

After you have uploaded an APNs certificate, it appears under the APN Certificate field on the
dashboard in the format com.apple.mgmt.<random string> (Enabled)

APNs Certificate: Test Now |

com.apple.mgmt.External.abfd343b-473d-497d-alce-a624dc606acl (Enabled)

Note: The APNSs certificate must be renewed annually. The expiration date is displayed on
the Organization Settings page. You can also use the Test Now button to check the
certificate’s validity. The test will return the certificate’s activation and expiration dates.

9. Click Save Changes when you are finished.

Your ZENworks Mobile Management server is now able to trigger iOS devices with push notifications and
use the built-in Apple MDM protocol.

Updating the APNs Certificate

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.

3. Click the Edit button next to the APNs Certificate field and make the needed changes. You can
change/disable/delete the APNs certificate or edit the password, Apple 1D, or URLSs if necessary.

Apple Push Notifications X

Chooseanaction:  (3) change APNs Certificate

() Disable APNs Certificate

() Delete APNs Certificate

Choose an APNs Certificate File: Browse...

Certificate Password:

Apple ID: l |

Use Default URLs:  []

Server URL: lhttps:/,-’sslS.compani

g.. https ServerAddress>/sync/iOSMDMSync.php

Check in URL: Ihttp s://ssl5.dompa n[

e.g., https://<ServerAddress>/sync/iOSMDMSync.php.

Submit
4. Click the Submit button.
5. Click Save Changes when you are finished.

Tip: You might want to test APNs functionality after an update to the certificate by manually
updating the APN profile on a device. Open ZENworks Mobile Management on an iOS device
and tap Config > Load Configuration Profile. The device installs the initial profile and, after a
brief delay, it prompts for the user's Exchange password. If the prompt for Exchange credentials
does not occur, resetting IS might resolve issues preventing the APNs from processing.
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Applying an APNs Certificate to
Multiple Organizations

If you have System Administrator privileges, you can apply an existing APNs certificate to multiple
organizations on the ZENworks Mobile Management server.

For example, on-premise systems that have categorized various divisions of a company by creating multiple
organizations will allow those organizations to share one APNs certificate.

1. Log into the ZENworks Mobile Management dashboard and select the System view.
2. Select Organization from the left panel.

3. Scroll down to the iOS Management section of the Organization Settings page. Click on the link
to the System Settings page under the APNs Certificate field. This option will not be available if
you are not logged in as a system administrator.

APNs Certificate: [ Edit. | [ Test Now |

Go to System Settings to apply an APNs Certificate to muitiple organizations.

You can also access System Settings directly by selecting System > System Administration >
System Settings.

4. On the System Settings page a list of organizations appears in the APNs Settings grid. If there is
an APNs certificate associated with the organization, the Apple ID, Expiration Date, and
Certificate Topic (certificate file) are listed beside it.

APNs Settings

Organization Name Apple ID Expiration Date Certificate Topic

Robin Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-0be2-243b095d35f7 |4

jmartin Aug 21 2015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

cas cschuster@ex07.notify Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

Ninja

jbyers Aug 21 2015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

arivera Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7

Archana Aug 212015 5:46AM | com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d35f7 -

cmclemore Aug 212015 12:46PM| com.apple.mgmt.External.96dd653a-0735-4533-9be2-243b095d357 |y
1 Set Up | I Enable I [ Disable | [ Delete ] 1 Copy To |
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There are several functions you can perform from this grid.

e Set Up an APNs certificate for the first time for one or multiple organizations
See also, Generating an APNs Certificate and Uploading the APNs Certificate.

¢ Renew an APNs certificate for one or multiple organizations (click Set Up)
See also, Renewing an APNs Certificate and Uploading the APNs Certificate.

e Disable/Enable or Delete an APNs certificate for one or multiple organizations

e Copy an existing APNSs certificate from one organization to one or multiple organizations (Copy To)
Caution:; Copying a certificate will overwrite any existing certificate associated with the organization(s)
selected.

To select multiple consecutive organizations in the grid, hold the SHIFT key and click on the first and last
organization.

To select multiple random organizations in the grid, hold the CTRL key and select organizations.
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Renewing an APNs Certificate

The Apple Push Notification service (APNs) certificate must be renewed annually. Organizations can keep

track of the certificate’s expiration date by setting an alert to occur prior to the date. The expiration date is also

displayed on the Organization Settings page.
To set the APNs Certificate Expiration alert:
e From the Organization page select Compliance Manager > Alert Settings > System Alerts.

e Enable the Apple Push Notification (APNs) Certificate Expiration alert and configure when you
want the reminder to begin and how often to be reminded. The default settings are to issue the
reminder 30 days prior to the expiration and repeat it every day.

e You can also choose to have an E-mail and/or SMS alert sent to an administrator.

Access Restrictions Alert Settings Enabled E-mail sms

Alert Recipients
5 » Access Restriction Based Alerts

Alert Settings
» (B3 Device Platform Restrictions » Non-Access Restriction Based Alerts

User Exceptions » Event Based Alerts

Watch List v System Alerts

v Apple Push Notification (APNs) ™ ] L ) ™ L

Certificate Expiration

Reminder prior to expiration {(Days): |30
Report Every {Days): (1

Follow the instructions below to renew the APNs certificate that was generated from the Apple Push
Certificates Portal or from Apple’s iOS Developer Enterprise Program (iDEP).

Essentially, you follow the same process used to obtain the original certificate. The only difference is in the
steps taken on the Apple Push Certificates Portal (Steps 4-6 below.)

To renew an APNSs certificate:

1. Create a new Certificate Signing Request (CSR) by using 1IS Manager (See the complete
instructions: [IS Manager 6 or IIS Manager 7/8)

2. Upload the CSR to Novell's ZENworks Mobile Management Certificate Request Portal. Click Get
Signed Request and save the signed request file. See the complete instructions.

3. Go to the Apple Push Certificates Portal at https://identity.apple.com/pushcert/ .

o If you originally obtained the certificate from the Apple Push Certificates Portal, log in with the

Apple ID you used to generate the certificate.

¢ If you originally obtained the certificate through iDEP, log in with the Apple ID for the iDEP
Agent account.
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4. On the page where your certificate is listed, click the Renew button next to the APNs certificate you

are renewing.

“Revoking or allowing this certificate to expire will require existing devices to be re-enrolled with a new push certificate.

About Apple Push Certificates Portal

Create and manage push certificates that enable your third-party server to work with the
Apple Push Notification Service and your Apple devices.
\ e .

L [V PRI )

o Store Mac iPod iPhone iPad iTunes Support Q

Apple Push Certificates Portal wrkernoriyeor.con | ERRRI
Certificates for Third-Party Servers
Service Vendor Expiration Date* Status Actions
Mobile Device Management  Novell Inc Jun 15, 2013 Active m

5. On the Renew Push Certificate page, click the Browse button and select the .request file (a .plist

format) to upload. Click Upload.

iPhone

Support

Apple Push Certificates Portal

Renew Push Certificate

Enter your Certificate Signing Request signed by your third-party server
vendor to renew the following push certificate.

Service Mobile Device Management
Vendor

The page where certificates are listed displays the certificate with a new expiration date. Click the
Download button next to the renewed certificate to download it and save it as a .pem file.

Use IIS to complete the CSR (See the complete instructions: IS Manager 6 or IS Manager 7/8)

From the ZENworks Mobile Management server dashboard, upload the renewed certificate.
Select System > Organization.

Click the Edit button next to the APNs Certificate field and choose Change APNs Certificate.
(See complete instructions: Updating the APNs Certificate).
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Appendix A: Generating the APNs
Certificate Using OpenSSL

The following set of instructions can be used by those who do not want to use Internet Information Services
(IIS) Manager or those who need an alternate method. These steps should work on any platform on which
OpenSSL runs.

1.

2.

Install OpenSSL for Windows from http://slproweb.com/products/Win320penSSL.html.

From the command line, create the CSR and private key:

openssl reqg -out apns.csr -new -newkey rsa:2048 -nodes -keyout apns.key
Enter the specified information with the Common Name set to your iTunes account name.
Follow the APNs signing instructions in this document to get the signed certificate (MDM_Novell
Inc_Certificate.pem) from Apple.

a. Uploading the CSR to the ZENworks Mobile Management Certificate Request Portal
b. Uploading the Intermediate Certificate to the Apple Push Certificates Portal

Merge the key and the certificate to a .pfx file:

openssl pkcsl2 -export -out apns.pfx -inkey apns.key -in MDM Novell
Inc Certificate.pem -certfile CACert.crt

Note: If a certfile does not exist, the last parameter of this command
(-certfile CACert.crt) can be dropped.

Specify the password to be used to protect the private key.

Upload the APNs certificate file (in .pfx file format) to the ZENworks Mobile Management console.
See Uploading the APNS Certificate to ZENworks Mobile Management, in this document.
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